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In this chapter you will learn;

²   definition of database
²   advantages of using a database
²   special characteristics of a database
²   using fields to create tables
²   identifying key fields
²   relational databases
²   relationships between tables
²   using queries to get data
²   using data forms
²   using reports to furnish information

 9.1   Database Concept

	 Chapter one included a description on what data and information are. This 
chapter covers saving data in an organized manner.	

	 Higher the amount of data it becomes difficult to keep in our memory. On 
such occasions writing these data is one method. That is called manual database. 
The other method is to maintain the data on an electronic medium. This is called an 
electronic database. Data can be retrieved efficiently when needed if it is saved on a 
database in a systematic way. Hence, the database is needed to save a large amount 
of data and to retrieve them very efficiently.

9 			   Database
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Examples 
It would be easy for you to remember names of your friends, but it would be difficult 
to retain all their phone numbers in your memory. You can get these details easily 
when needed if you write names and phone numbers in a book (Figure 9.1) or save 
them in a mobile phone (Figure 9.2). Thus, the phone book can be considered a 
simple database. 

Defining a Database - Collection of organized data can be defined as a database

9.1.1  Advantages of Databases

   ²     More efficient in retriving  information.
	 Required information can be found very quickly as data is properly 
organized in tables in a database.

²² Easy to obtain copies.
	     	 Electronic databases can be copied very easily.

²² Smaller physical space to store data.
	     	 Though  more physical space is needed to maintain a manual  
	      database, a small space is sufficient to save data on an electronic medium.
²² Data analysis can be carried out efficiently.
	 	 Only the necessary data can be selected and processed.

²² Data can be shared.
	 The same database can be used in different application software.

²² Independence of data.
	     	 Though database and software are connected, database  
	   tables can be updated without changes to the application software.  
	     Therefore, data and software are independent.

Figure 9.1 – telephone numbers (manual) Figure 9.2 – telephone numbers (electronic)



253
253253              For free distribution

9.1.2  Features of a Database

•   Minimal data redundancy

If the same data is stored in several tables, this is called data redundancy. 
	
	 For instance, the name of a student may be recorded separately in the 
admission card and the library membership card.  When a name is changed, that 
name should be edited separately in all documents. Given below is an example 
where the name ‘Firosa Lai’ is changed as ‘Firosa Rafeeq’.

 Table 9.1 - Admission table

Student 
Number

Name Date of Birth Date of 
Admission

Name of the 
Guardian

100 Manoj Dayarathne 2$9$2008 1$1$2014 G. Dayarathne

101 Firosa Lai Rafeeq 4$2$2008 1$1$2014 K. Fais
				        

			               Table 9.2 - Library table

Student Name Name of the Book Borrowed Date Return Date
Firosa Lai Rafeeqa Folk Songs 2$9$2014 16$9$2014

Manoj Dayarathne Drama 3$9$2014 17$9$2014

Firosa Lai Rafeeq Basic Maths Concept 3$9$2014 17$9$2014

Manoj Dayarathne Drama 4$9$2014 18$9$2014

	

	 However, by storing related database in tables, data redundancy can be 
minimized. In the following table, a student name is recorded only in one table.  
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 Table 9.3 - Relational Database

Student 
Number

Name Date of 
Birth

Date of 
Admission

Name of the 
Guardian

100 Manoj Dayarathne 2$9$2008 1$1$2014 G. Dayarathne

101 Firosa Lai Rafeeq 4$2$2008 1$1$2014 K. Fais

Student 
Number

Book 
Number

Borrowed 
Date

Return Date

101 2222 2/9/2014 16/9/2014
100 3333 3/9/2014 17/9/2014
101 1111 3/9/2014 17/9/2014
100 3333 4/9/2014 18/9/2014

Book 
Number

Title Author’s Name

1111 Basic Maths 
Concept

Sivathasan 
Ramanathana

2222 Folk Songs Jayantha Bandara

3333
Drama Padmamali Menike

² Data consistency : By minimizing data redundancy, the same 
    data being saved in various tables can be reduced or prevented. This enables 
      to maintenance of data consistency.
	 If you consider the example above, student data, data about books and  
    usage of books are saved separately in different tables. As such data such as  
          name of a student or a book should be recorded only once. Thus, data consistency  
      is maintained. 

²  Increases efficiency : Since database tables are properly organized, saving 
      and reading data can be carried out efficiently. Hence, efficiency is higher.
	 As per example above, let us consider the change of name from Firosa  
    Lai to Firosa Rafeeq. If the same data (Firosa Lai) are recorded in different  
    tables, more time is spent to find all these places. This leads to inefficiency.  
   However, in related databases data consistency increases speed. Hence, 
      efficiency is increased. 

²       Increases accuracy  : Since data redundancy can be minimized in a database, data 
       consistency is maintained. This increases accuracy.    
	 Let us consider the example above where Firosa Lai is changed to Firosa  
    Rafeeq. If several places are corrected, one mistake would lead to inaccurate  
     information.       
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    However, in the above database only one table is need to be updated to 
change Firosa Lai to Firosa Rafeeq. This ensures data consistency. Therefore, 
the accuracy of data is very high.

²  Increases validity : Properties of fields can be assigned when a database  
    is planned. Validity can be checked at the data entry stage. This increases the 
     validity of the database.

                    For instance, field attributes can be imposed as fees to be indicated in 
two decimals with minimum fees being 1000 which is mandatory.        		

        

Figure 9.3 - Properties of  data type

²  Security : Unauthorized access can be controlled by using a password  
	    and encypting the database. This increases security.

		  Data encrypting is translating data in such a way that unauthorized personnel 
cannot read it.  In the following figure 9.4, data available in Employee table are 
encripted so as it cannot be understood by an unauthorized person.

Fees

Field name Data Type

Field 
properties
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9.1.3 Electronic and Manual Databases

	 In an electronic database, data can be saved in a very small space which 
consists of an audio or video medium. Given below is a comparison of electronic 
and manual databases. (Table 9.4)

		    Table 9.4 – comparison of manual and electronic database

Manual Database         Electronic Database
Less efficient More efficient
Less accurate More accurate
Less credible More credible
Difficult to analyse data Easy to analyse data
Should present in the order of input Can change the data input order 
Difficult to delete unnecessary data Easy to delete unnecessary data
Difficult to update data Easy to update data
More space is needed to save data A very small space is needed to save data

More man power is needed Less man power is needed

Figure 9.4 - Data Encription
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9.1.4  Introduction to Relational Database

	 A collection of fields related to one person or object is called a record.
	 A collection of records is called a data table.

	 A collection of related tables is called a relational database.

Field 
Student 
Number

Name Date of 
Birth

Date of 
Admission

100 Manoj Dayarathne 2/9/2008 G. Dayarathne

101 Firosa Lai Rafeeqa 4/2/2008 K. Fais

Student 
Number

Book 
Number

Borrowed 
Date

Return 
Date

101 2222 2/9/2014 16/9/2014

100 3333 3/9/2014 17/9/2014

101 1111 3/9/2014 17/9/2014

100 3333 4/9/2014 18/9/2014

Tables

Records

Relational Database

	 Let us learn how a related database is built step by step. A collection of 
fields make a record, a collection of records make a table and a collection of tables 
make a relational database.

Figure 9.5

Relational database

Table 1 + Table 2 + Table 3 + Table 4 …….. (Tables)

Record 1 + Record 2 + Record 3 + Record 4 ………. (Records)

Table

Record

Field 1 + Field 2 + Field 3 + Field 4 + Field 5 ……… (Fields)
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Example 
Student record book is a very important document for every student. Biodata of a 
student and the marks obtained for each subject with the rank in all three terms in 
all grades are included. 

				    Table 9.5 – Biodata form

Admission No : 1426 Admission No : 1427 Admission No : 1428
Name : Kavindu 
Prabashwara

Name : Meenadevi 
Ramanathan

Name : Mohommad 
Malikkar

Date of Birth : 2005.05.23 Date of Birth : 2005.08.12 Date of Birth : 2005.02.07
Gender : Male Gender : Female Gender : Male
Tel No : 0352287571 Tel No : 035 22 35696 Tel No : 0352815402

	 Five details related to each student are given above. Thus, data such as 
Kavindu Prabashwara, Meenadevi Ramanathan, Mohommad Malikkar represent 
one field. To name such a field, a ‘field name’ is used.
	 Let us create a table recording details under each field name. (Table 9.6)
			        Table 9.6 - Student Records

Admission 
No

Name Date of 
Birth

Gender  Student  Phone 
Numbers

1426 Kavindu 
Prabashwara

2005.05.23 male  0352287571   

1427 Meenadevi 
Ramanathan

2005.08.12 female  0352235696

1428 Mohommad 
Malikkar

2005.02.07 male  0352815402 

	 A column of the table represents one field. Thus, the above table consists of 
five fields. They are admission number, Name, Data or Birth, Gender and Telephone 
number.

A collection of fields makes a record. Hence, the  above table has three records.
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	 There is the possibility of entering the same data again in the columns 
such as Name, Date of Birth, Gender and Tel No. However, a datum entered in the 
column of Admission No will not be repeated. Hence, the field Admission No is 
more suitable to uniquely identify a record.	
	 What are the books borrowed by Firosa Rafeeq? Let us learn how this is 
found in relevent tables.

Student 
Number

Name Date of 
Birth

Date of 
Admission

Name of the 
Guardian

100 Manoj Dayarathne 2$9$2008 1$1$2014 G. Dayarathne

101 Firosa Rafeeq 4$2$2008 1$1$2014 K. Fais

Student 
Number

Book 
Number

Date 
Borrowed 

Date 
Returned

101 2222 2/9/2014 16/9/2014
100 3333 3/9/2014 17/9/2014
101 1111 3/9/2014 17/9/2014
100 3333 4/9/2014 18/9/2014

Book 
Number

Title Author’s Name

1111 Basic Maths 
Concept

Sivathasan 
Ramanathan

2222 Folk Songs Jayantha Bandara
3333 Drama Padmamali Menike

 Table 9.6 

Field Names

Admission 
No

Name Date of 
Birth

Gender Telephone No

1426 Kavindu Prabashwara 2005.05.23 male 0352287571

1427 Meenadevi 
Ramanathan

2005.08.12 female 0352235696

1428 Mohommad Malikkar 2005.02.07 male 0352815402

 Record

Row

Column

       Table 9.7 - Componants of Data Table
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9.1.5  Primary Key 

	 A column (or a combination of columns) which enables to identify a record 
uniquely is called primary key. 	   

Figure 9.6

For instance, study the table given below which consists of data on a few books.
Table 9.7 - Book Table

Accession 
No

Title Author’s Name Price of 
Book

Number 
of Books

2131 Let’s Access Internet Mahesh Gankanda Rs.275.00 10

2132 Computer Studies Suranimala 
Basnayaka

Rs.300.00 5

2133 Essay Writing Nimali Bogoda Rs. 225.00 12

2134 Education Psychology Dayanath 
Jayasekara

Rs.400.00 6

2135 Tamil Language Learning Raj Sudakaran Rs.225.00 8

2136 Computer Studies Mohommad Niyas Rs.150.00 4

2137 Sinhala Tamil Dictionary Raj Sudakaran Rs.325.00 6

 

In this table,

•	 Accession numbers do not have duplicates (unique)

•	 Both authors Suranimala Basnayaka and Mohommad Niyas have authored 
Computer Studies.

•	 Raj Sudakaran has authored both Tamil Language Learning and Sinhala Tamil 
Dictionary.

Example - National Identity Card Number 
              School Admission Number 

observation  

	 Special attributes of a primary key
	 •	 Should not be empty (data being there is mandatory)
	 •	 No duplicate values (same values do not exist)
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•	 The price of both books Essay Writing and Tamil Language Learning is the 
same.

•	 Both books Education Psychology and Sinhala Tamil Dictionary have six 
copies.

	 According to these details, the Accession Number is the most suitable fields 
for the primary key.

Note: The Primary key of a table is underlined to identify as unique. (table 9.8)

					     Table 9.8

Accession 
Number

Title Author’s 
Name

Price of the 
Book

Number of 
Copies

			 

9.1.6  Composite Primary Key

	 The primary key which consists of two or more columns of a table uniquely  
identifies a record is called Composite Primary Key.

 

Look at the table given below about the captain and vice captain of a school.

	

Year Sport Captain Vice Captain
2013 Cricket Rashmi 

Senarathne
Mubharak Husein

2013 Football Jaliya Saranga Vinothen Raj
2013 Volleyball Ahammed Nawas Sudesh Tharanga
2014 Cricket Mubharak Husein Bhanu Dayarathne
2014 Football Jaliya Saranga Ahammed Nawas
2014 Volleyball Bhathiya Gamlath Sudesh Tharanga

 
Composite Key Both the year and sport are needed to uniquely identify 

a record.

		 

Example

Table 9.9 – Sports Table	
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	 Since the column data of this table containes duplicate. There is no single 
column to uniquely identify records. There should be a definite captain and a vice 
captain for a sport in a year. Hence, as far as the combination of two columns; 
year and sport is considered, identity of records exists. Hence, combination of both 
fields ‘year’ and ‘sport’ can be considered as the primary key. The composite key 
made of the combination of these two columns is suitable for the primary key in this 
table. When indicating the composite primary key, fields are separately underlined. 
(Refer Table 9.10)

	 			         Table 9.10

Year Sport Captain Vice Captain

The composite primary key of this table = Year + Sport 

9.1.7  Foreign Key 

	 If a field (or a combination of fields) of one table can be used to uniquely 
identify rows of another table, this/these field/s is/are called the foreign key.This 
key builds connection of two tables.

Table 9.11 –  Student Table 

When considering the tables 9.11 and 9.12, Registration 
Number is the primary key of 9.11 - Student Table where 
as Registration Number is the foreign key of 9.12 - Subject 
Table. Further, a separate primary key is available for subject 
table and that is candidate number.

Registration 
Number

Name Date of 
Birth

Date of 
Admission

Name of the 
Guardian

100 Manoj 
Dayarathne

2/9/2014 1/1/2014 G. Dayarathne

101 Firosa Rafeeq 4/2/2014 1/1/2014 K. Fais

Candidate 
No

Maths Science Sinhala English Registration  
No

449683 B A C C 100
449697 A B B A 101

 9.12 - Subject Table 	

Primary Key

Foreign Key 
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Example
Given below in Table 9.13 are ICT subject marks of three students scored in the first 
term. 	 	

				    Table 9.13 – First term marks

Admission No Name Date of 
Birth

Marks Term Year

1426 Kavindu Prabashwara 2005'05'23 69  1 2014

1427 Meenadevi 
Ramanathan

2005'08'12 82  1 2014

1428 Mohommad Malikkar 2005'02'07 47  1 2014

	

	 When entering marks of these students scored in the second term, the fields 
such as admission number, name and date of birth should be entered again. (Refer 
Table 9.14)
			           Table 9.14 – Second term marks

Admission 
No

Name Date of 
Birth

Marks Term Year

1426 Kavindu Prabashwara 2005'05'23 69 1   2014

1427 Meenadevi Ramanathan 2005'08'12 82 1 2014

1428 Mohommad Malikkar 2005'02'07 47 1 2014

1426 Kavindu Prabashwara 2005'05'23 79 2 2014

1427 Meenadevi Ramanathan 2005'08'12 68 2 2014

1428 Mohommad Malikkar 2005'02'07 66 2 2014

	 Recording column data repeatedly is called data duplication.

Disadvantages of data duplication

(i)   Inability to select a primary key field to maintain identity of records.
(ii)  Inability to analyse data properly.

	 Though the number of students who have scored above 60 marks is 5 as per  
	 the above table, the actual number of students in the class is 3. Hence, a  
	 proper data analysis cannot be done.

observation 

	 Special features of a foreign key
•  Builds a connection between two tables.
• The related data of the primary key field exist in the other  

	     table.
•  Foreign key of one table is the primary key of the other table.
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(iii)  Reduced efficiency
		  When entering marks of several years in the above table, more time is spent  
		  to enter the admission number, name and date of birth of the same student.  
		  This reduces efficiency.
(iv)  Possibility to get inaccurate data is high.

		  There can be errors in entering the same data repeatedly. Mohommad  
		  Malikkar can be recorded as Mohommad Malakkar in another place. These  
		  mismatches can lead to inaccurate data. Hence, accuracy becomes low.

(v)   Difficult to input data.
		  To enter the marks of a student, his/her name and date of birth should be  
		  entered repeatedly.

(vi)  Possibility to make errors in deleting data.

		  As there are several records related to a student, there can be errors in  
		  deleting data.

(vii)  Difficult to update data.
		  As there are several records related to one student, attention should be paid to 
		  each record in updating it.

	 These difficulties are created as all data are stored in one table. Hence, to 
minimize such difficulties, a table can be divided into several tables.
	 Let us create two tables: Student Table and Marks Table, by removing the 
fields which cause data duplication.
Let us create Student Table (Table 9.15) which consists of Admission Number, 
Name and Date of Birth.

	 In the Student Table, there is the possibility of data in Name and Date of 
Birth fields being duplicated. However, data does not duplicate under Admission 
Number. Hence, Admission Number is more suitable to identify records uniquely. 
Therefore, the primary key of the Student Table is the Admission Number.	

Table 9.15 – Student Table

Admission No Name Date of Birth
1426 Kavindu Prabashwara 2005'05'23

1427 Meenadevi Ramanathan 2005'08'12

1428 Mohommad Malikkar 2005'02'07
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	 Let us create a Marks Table (Table 9.16) which consists of the Admission 
Number, Marks, Term and Year.

Table 9.16 – Marks Table

Admission No Marks Term Year
1426 69 1 2014

1427 82 1 2014

1428 47 1 2014

1426 79 2 2014

1427 68 2 2014

1428 66 2 2014

	

	 There is only one datum in the Student Table related to Admission Number 
of Marks Table.
	 Hence, the field of the Admission Number is the primary key of the Student 
Table and foreign key of the Marks Table.

9.2  Creating a Simple Database Manually

Data type : a type of data related to one field is called a data type. Let us learn about 
	       some commonly used data type.

²² Numeric: used for calculations. Exists in several forms.
∗	 Integer: plus or minus whole numeric figures.
			   E.g.: 12, -23
∗	 Real: plus or minus numbers with decimal places.
			   E.g.: 8.125, -2.64, 4.00			    

²² text: composed of letters, numbers or special characters (Eg-  %, *, -). Though 
numbers are used, it is not used for calculations.		

	 	 E.g.: National identity card number –889534731V
        		  Telephone number –0112785123, 0112 - 985123
²² Currency: used to indicate monetary values.

		  E.g.: $12.45, Rs.35.00
²² Date / Time: indicates dates and time

			   E.g.: 12/23/2013, 7.35 a.m
²² Boolean: there are only two Boolean (logical) values; True and False.	

	
	 The size of a field can be changed according to the data type and number of 
data input to that field. 
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E.g.: Field Name (Column Name)               Number of fields (Column Width)
           		 Subject Name                                            15
           		 Subject Code                                              5
	
Data type related to the field should be identified when the table is created.
		
		  Field Name                                       Data Type
    	 Accession number of the book                   	  Text
      		      Title                                                  Text
      	         Author’s Name                                         Text
     	          Price of Book                                       Currency
     	       Number of Books                                     Number

(1) Tabulate details of 10 books in your library under the fields mentioned 
	       above.

(2) Create a table which is suitable to enter marks scored by the students 
	     in your class. Include Admission Number, Name and the Marks for 
	        subjects you study in this table.

Mention the most suitable data type for the fields in Table 9.17 given below.
				  

				          Table 9.17 

Field Data Type
Admission Number

Date of Admission
Subject Code
Doctor’s Fee
Department Name 
Number of Passengers
Is Registered?

(3)  Explain with examples the importance of selecting the most suitable data type 
       for fields.

Activity 
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9.3  Converting a Manual Database to an Electronic  		
       Medium 

	

	 Let us learn electronic databases with the purpose of  converting a manual 
database to an electronic medium. 

Definition
	 A collection of objects which facilitates planning and maintenance of the 
database to the user is called a Database Management System (DBMS). This 
consists of several objects like tables, queries, forms and reports. (Refer Figure 9.7)

	 		

		  	 Figure 9.7 – Objects of a Database Management system  

9.3.1  Database Management System Software
	

	 Given below in Table 9.18 are some DBMS software manufactured by 
various companies.

	    Table 9.18 – Various database management systems and manufacturing companies

Software Manufacturing Company
Access Microsoft Company
Base The Document Foundation
Oracle Oracle Cooperation

(DBMS)Reports

Forms

Queries

Tables
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9.3.2 Using of Database Management System Software 

	 In this unit, only Microsoft Office Access and LibreOffice Base software 
are discussed. 

1'  Starting DBMS software 
	 Please note that the commands used to run software can be different 
according to the operating system.

2' Planning a Data Table
	 Open database software and plan a table with the fields and data types as 
given in 9.8. Name the table as ‘Library’.

3'  Creating the Primary Key for a Data Table 
	 Data should not be duplicated to uniquely identify rows of a table. Identity 
of records can be maintained by using a column or a combination of columns of a 
table as a primary key field. Convert the field of ‘Accession Number’ in the above 
figure 9.8 to the primary key field.

For Microsoft OfficeAccess''' 

Create → Table Design → Give the field 
name and data type → Design properies 

→  Save the table
 

For LibreOffice Base'''

Select 'Table' in Design View → Give 
the field name and data type → Design 
Properties → Save the table.

Figure 9.8 – Fields and data types of ‘Library’ table.

For Microsoft OfficeAccess''' 

Start→ Programs → Microsoft Office 
→ Microsoft Office Access → Blank 
Database → Select Folder and Type 
Name → Create

For LibreOffice Base'''

Start → Programs → LibreOffice →
LibreOfficeBase → Create a new 
database → Next → Finish → Select 
Folder and Type Name → Save
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4'  Entering Data to the Table
The table view should be changed to input data to a prepared table.

Enter data into the Library Table as shown in Figure 9.10

			   Figure 9.10 - Records of Library Table

  Figure 9.9 - Library Table with the Primary Key

For Microsoft Office Access'''

 

Select the table from 'All  Access 

Objects' window → Select' Data Sheet 

View' → Enter data → Close the table.
	 	

For LibreOffice Base'''

Double click the table under Tables or 

select Open by clicking the right button 
→ Enter data → Close the table.

For Microsoft OfficeAccess'''

Give field name and data type → Select the 
row/ rows that should be made as Primary 
key → Click on Primary key →  save the 
table. 

For LibreOffice Base''''

Give field name and data type adjust 
properties → Right click on the line 
which contains the field need making 
primary key → Select Primary key → 
save the table.
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 9.4  Creating a Relational  Database
	 You have studied the Primary Key and Foreign Key of a table in unit 9.1. 
Rather than keeping all the data in a single table, it is easier, more efficient and 
productive to input, update and delete data if those are recorded separately in 
different tables. Hence, let us study this section well to break a data table into 
several simple tables and to build relationships between these.

	 When creating a relational databases, several type of relations can exist 
among tables. They are known as one-to-one, one-to-many and many-to-many.

9.4.2 One-to-one Relationship
	 If only a row of a table is related to a row of another table, it is called a  
one-to-one relationship.

	 Two tables exist as A and B.  A row in table A is related to one row in Table 
B and a row in Table B is related to one row in Table A. 

Example

Given below is Table 9.19 which includes the marks students scored of the Grade 
5 scholarship exam.

Table 9.19– Scholarship Marks

Admission No Name Date of 
Birth

Index No Marks

1426 Kavindu Prabashwara 2005'05'23 23234 151

1427 Meenadevi Ramanathan 2005'08'12 23876 186

1428 Mohommad Malikkar 2005'02'07 23758 172

1429 Rashmi Janodara 2005'06'16 23765 193

	

Let us tabulate data in Table 9.19 into two tables: Table 9.20 – Student Table and 
Table 9.21 – Marks Table.

	

	

Table 9.20 – Student Table

Index No Marks Admission 
No

23234 151 1426

23876 186 1427

23758 172 1428

23765 193 1429

	

Admission 
No

Name Date of 
Birth

1426 Kavindu 
Prabashwara

2005.05.23

1427 Meenadevi 
Ramanathan

2005.08.12

1428 Mohommad 
Malikkar

2005.02.07

1429 Rashmi 
Janodara

2005.06.16

Table 9.21 – Marks Table
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	 A record of the Marks Table is related to only one record of the Student 
Table. A record of the Student Table is related to only one record of the Marks Table 
as well.
	 The primary key of the Student Table is the Admission Number and it is the 
foreign key of the Marks Table. The Primary key of the Marks Table is the Index 
Number. The relationship built between these two tables through the foreign key is 
one-to-one. (Figure 9.11)

		
Admission No Name Date of Birth

	

Index No Marks Admission No

	 An arrow is drawn from the foreign key to the primary key to indicate the 
relationship. 

9.4.2  One-to-many Relationship

	

	 If each record of a table is related to several records of the other table, this 
is called a one-to-many relationship. 
	 If the tables are A and B, and if B is the related table, the following Table 
9.22  shows one-to-many relationship.

Student Table

Marks Table

Figure 9.11 – Indicating one-to-one relationship

 9.4  Creating a Relational  Database
	 You have studied the Primary Key and Foreign Key of a table in unit 9.1. 
Rather than keeping all the data in a single table, it is easier, more efficient and 
productive to input, update and delete data if those are recorded separately in 
different tables. Hence, let us study this section well to break a data table into 
several simple tables and to build relationships between these.

	 When creating a relational databases, several type of relations can exist 
among tables. They are known as one-to-one, one-to-many and many-to-many.

9.4.2 One-to-one Relationship
	 If only a row of a table is related to a row of another table, it is called a  
one-to-one relationship.

	 Two tables exist as A and B.  A row in table A is related to one row in Table 
B and a row in Table B is related to one row in Table A. 

Example

Given below is Table 9.19 which includes the marks students scored of the Grade 
5 scholarship exam.

Table 9.19– Scholarship Marks

Admission No Name Date of 
Birth

Index No Marks

1426 Kavindu Prabashwara 2005'05'23 23234 151

1427 Meenadevi Ramanathan 2005'08'12 23876 186

1428 Mohommad Malikkar 2005'02'07 23758 172

1429 Rashmi Janodara 2005'06'16 23765 193

	

Let us tabulate data in Table 9.19 into two tables: Table 9.20 – Student Table and 
Table 9.21 – Marks Table.

	

	

Table 9.20 – Student Table

Index No Marks Admission 
No

23234 151 1426

23876 186 1427

23758 172 1428

23765 193 1429

	

Admission 
No

Name Date of 
Birth

1426 Kavindu 
Prabashwara

2005.05.23

1427 Meenadevi 
Ramanathan

2005.08.12

1428 Mohommad 
Malikkar

2005.02.07

1429 Rashmi 
Janodara

2005.06.16

Table 9.21 – Marks Table
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Table A Table B (Related table)
A record in Table A can be related to 
several records in Table B.

A record in Table B can be related to 
only one record in Table A.

There can be records which are not 
related to records of Table B.

There cannot be records which are not 
related to records of Table A.

Data in the column which includes the 
primary key cannot duplicate.

Data in the column which includes the 
foreign key can duplicate.

Having a record in Table B related to a 
record in Table A is not mandatory.

It is mandatory to have at least one row 
in Table A which is related to Table B.

Example
Refer Table 9.23 given below which includes personal data of students and payments 
of service and facility fees.

Table 9.23 - service and facility fees

Admission 
No

Name Date of 
Birth

Receipt 
Number

Payment 
Date

Fees

1426 Kavindu 
Prabashwara

2005'05'23 1000 2014'01'04 40'00

1427 Meenadevi 
Ramanathan

2005'08'12

1428 Mohommad 
Malikkar

2005'02'07 1001 2014'01'06 120'00

1426 Kavindu 
Prabashwara

2005'05'23 1002 2014'01'12 80'00

	

	 In this table, the fields 'Payment Date' and 'Fees' depend on the Field Receipt 
Number. Further, data is unique in the Receipt Number Field. The reason for this is 
that receipt numbers will not be same. Anyway, there can be incomplete records in 
the table as receipts should be issued in the order of payment. (Indicated as R in the 
table) Further, data duplication can also be seen here.
	 Hence, let us break this table into two tables: Table 9.24 –Student Table and 
9.25 – Fees Table.
	 The Receipt Number is the primary key of the Fees Table. Admission 
Number is the primary key of the Student Table and the Foreign Key of the Fees 
Table.

Table 9.22 – Features of a one-to-many relationship   

R



273
273273              For free distribution

Student Table

Admission No Name Date of Birth

Facility Fee Table

Facility Receipt 
No

Payment Date Fees Admission No

	 	 	

	 If a student can pay fees a maximum of three times, there can be 0, 1, 2 or 3 
rows in Facility Fees Table related to a record of the Student Table
•	 If number of records is 0, this means fee is not paid.
•	 If number of records is 1, this means fee is paid once only.
•	 If number of records is 2, this means fee is paid twice.
•	 If number of records is 3, this means fee is paid thrice.

	 Thus, there can be no or several rows in the Fees Table related to a 
row of the Student Table.  Hence, the relationship between these two tables is  
one-to-many

		  			

	   	 		

 Figure 9.12 - One-to-Many Relationship

Admission No Name Date of Birth
1426 Kavindu Prabashwara 2005'05'23

1427 Meenadevi Ramanathan 2005'08'12

1428 Mohommad Malikkar 2005'02'07
	
	         Table 9.25 - Facility Fees  Table

Receipt 
Number

Payment 
Date

Fees Admission 
No

1000 2014'01'04 40'00 1426

1001 2014'01'06 120'00 1428

1002 2014'01'12 80'00 1426

	 Table 9.24 – Student Table
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9.4.3  Many-to-many Relationship

	 If a record of a table is related to several records of another table and if a 
record of that related table is related to several records of the other table, there is a 
many-to-many relationship between those two tables.

Example
Students take part in sports (team) as an extra curricular activity. There are sports 
such as cricket, volleyball and football. A student can do at least one of these sports. 
Further, there should be a team for each sport.
Refer Table 9.26 given below which includes these data. According to this table,
	                      Figure 9.26 – Table of students who do sports

Admission 
No

Name Date of 
Birth

Sport 
No 

Sport Team Number of 
permanent 
members 

1426 Kavindu 
Prabashwara

2005'05'23 S001 Cricket A 11

1426 Kavindu 
Prabashwara

2005'05'23 S002 Football A 16

1428 Mohommad 
Malikkar

2005'02'07 S001 Cricket B 11

1428 Mohommad 
Malikkar

2005'02'07 S002 Football A 16

1428 Mohommad 
Malikkar

2005'02'07 S003 Volleyball B 06

1429 Janith Asheka 2005'04'15 S001 Cricket A 11

1429 Janith Asheka 2005'04'15 S003 Volleyball A 06

There is data duplication in this table. To minimize data duplication, let us break 
these data into separate tables. Include Sports data into Sports Table (Table 9.27) 
and student data into Student Table (Table 9.28).

	

Admission 
No

Facility fees  
Table

Date of 
Birth

1426 Kavindu 
Prabashwara

2005'05'23

1428 Mohommad 
Malikkar

2005'02'07

1429 Janith Asheka 2005'04'15

Table 9.27 - Student Table                                                

Sport 
No.

Sport Number of 
permanant 
Members

S001 Cricket 11
S002 Football 16

S003 Volleyball 6

Table 9.28 - Sports Table
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Many-to-many relationship between Student Table and Sports Table is converted 
to one-to-many relationships in related databases. For this, another table is needed 
apart from the two tables given above. (Let us name that table as Students Sports 
Table – Table 9.30) Let us include Admission Number of Student Table to represent 
students and Sport Number of Sports Table to represent sports.

	 The Admission Number is the Primary key of the Student Table and the 
foreign key of Students Sports Table. 

	 The Sport Number is the primary key of the Sports Table and the foreign 
key of Students Sports Table. 

	 The primary key of the Students Sports Table is Admission Number + Sport 
Number.

	 Refer Figure 9.13 which gives relationship when two tables like the 
Student Table and Sports Table with many-to-many relationships are converted to  
one-to-many relationships.

Admission No Name Date of Birth
1426 Kavindu 

Prabashwara
2005'05'23

1428 Mohommad 
Malikkar

2005'02'07

1429 Janith Asheka 2005'04'15

Figure 9.29 – Student Table	

Admission 
No

Sport No Team

1426 S001 A

1426 S002 A

1428 S001 B

1428 S002 A

1428 S003 B

1429 001 A

1429 S003 A

Figure 9.31 – Sports Table

Sport No Sport Number of permanent 
members

S001 Cricket 11
S002 Football 16
S003 Volleyball 6

Figure 9.30 - Students Sports Table
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Representing two tables with many-to-many relationships as two  
one-to-many relationship

Figure 9.13 - Many-to-Many Relationship
Thus,
	 There is a one-to-many relationship between the Student Table and the 
Students Sports Table.
	 There is a one-to-many relationship between Sports Table and Students 
Sports Table.
	 Hence, by using an extra table, many-to-many relationships can be converted 
to one-to-many relationships.

9.5   Creating a Relational Database Using Database         		
        Management System Software

	

	 Let us learn how to build relationships between tables using a Database 
Management System software. For this, create the tables given below: Figure  
9.14 – Student Table (using field names and data types given) and Figure  
9.15 – Marks Table. 

Student Table

Admission No Name Date of Birth

Students Sports Table

Admission No Sport No Team

Sports Table

Sport No Sport Number of permanent members 
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9.5.1 Build up relationship between tables

Figure 9.14  – Field names and data types of Student 
Table.

Figure 9.15 – Field names and data types of marks table.

For Microsoft Office Access...

Select Database Tools → Select Relationship 
command → Select the table which should 
be related → Click 'Add' command button. 
(Indicate the number of tables required) → 
Drag the Primary Key to the foreign key of 
the table which should be related (Figure 9.16) 
→ Select 'Enforce Referential Integrity' on 
'Edit Relationship' Dialogue Box (Refer 9.17) 
→ Select 'Cascade Update Related Field' and 
'Cascade Update Related Records' → Click 
'Create' command button.  

For LibreOffice'''

Select Tools Menu → Select Relationship 
command → Select the table which should 
be related → Click Add command button. 
(Indicate the number of tables required) 
→  Drag the Primary Key to the foreign 
key of the table which should be related → 
Right click on Relationship and select Edit 
→ Select 'Update Cascade' under 'Update 
Option' on Relations Dialogue Box. Select 
'Delete Cascade' under 'Delete Option' 
(Figure 9.18) → Click 'OK' command 
button.  
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Figure 9.16 - One-to-many relationship between two tables.

Figure 9.18 – A Relations Dialogue Box (LibreOffice Base)

Figure 9.17 – Editing Relationship Dialogue Box (Access)
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	 The Admission Number is the primary key of the Student Table and the 
Foreign Key of the Marks Table.

observation 

	 Special Features in Related Tables

	 As soon as the values of a primary key field of the Student Table are updated 
using 'Referential Integrity,' the foreign key field values of the related table are 
automatically changed.
	 Further, when a record of the Student Table is deleted, the related records of 
the related table are automatically deleted.
	 First, data should be entered to the student Table. After that, data can be 
entered to the Marks Table.
	 After entering the marks to the Student Table, data can be entered to the 
Marks Table through it. 
	 For this, click on the + mark which is in front of the Admission Number of 
the Student Table. Then data can be entered to Marks Table easily. (Refer Figure 
9.19)

Figure 9.19 – Entering data to Student Table and Marks Table.
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9.6  Creating Forms to Entering and Displaying Data
	

	 Now you have knowledge about creating a table and entering data to it. 
Forms are used to enter data to a table in Database Management Systems. Further, 
forms are used to display entered data as well.	

	 Here, a row of a table is displayed and entered as a record in a form. (Refer 
Figure 9.18)	

	 Each input record is entered to the last column of the table. Each record of 
the table can be filled one by one through the form. For this, the Record Navigation 
Bar of a form is used. (Refer Figure 9.20)

Data Table

Figure 9.18 – Table and Data Form

Name Address Telephone No Email
Anwar Athurugiriya 0773684949 anvmom@dd.uk
Nimal Galewela 07184632481 nigl@ya.com

Sudakaran Kandy 0817587484 suda@gmail.com
Saman Kegalle

Name

Name Nimal

Saman 
Galewela

Kegalle
07184637481Address

Address

Telephone No

Telephone No

Email

Email nigl@ya.com

Display data on form

Data input through form

Figure 9.20 – Checking records from a data form.

		
New (empty) 

Record

First Record
Previous Record

Existing 
Record

Total Records

Next Record
Last Record
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1'  Building a Data Form

For Microsoft Office Access '''

Create → Form Design → Add Existing Fields → Show tables → Select the required table 
→ Drag table fields to the form (Refer Figure 9.21)

Figure 9.21 –Data form to enter data to the Student

2'  Showing Table Records in Data Form

 

	

For Microsoft Office Access '''

Home Tab → View → Form View (Refer Figure 9.22)

Figure 9.22 – Showing records in the Student Table

9.6  Creating Forms to Entering and Displaying Data
	

	 Now you have knowledge about creating a table and entering data to it. 
Forms are used to enter data to a table in Database Management Systems. Further, 
forms are used to display entered data as well.	

	 Here, a row of a table is displayed and entered as a record in a form. (Refer 
Figure 9.18)	

	 Each input record is entered to the last column of the table. Each record of 
the table can be filled one by one through the form. For this, the Record Navigation 
Bar of a form is used. (Refer Figure 9.20)

Data Table

Figure 9.18 – Table and Data Form

Name Address Telephone No Email
Anwar Athurugiriya 0773684949 anvmom@dd.uk
Nimal Galewela 07184632481 nigl@ya.com

Sudakaran Kandy 0817587484 suda@gmail.com
Saman Kegalle

Name

Name Nimal

Saman 
Galewela

Kegalle
07184637481Address

Address

Telephone No

Telephone No

Email

Email nigl@ya.com

Display data on form

Data input through form

Figure 9.20 – Checking records from a data form.

		
New (empty) 

Record

First Record
Previous Record

Existing 
Record

Total Records

Next Record
Last Record
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3'  Entering Control Wizards to a Form

Figure 9.23 – controlling Tools

Figure 9.24 – Command Button Wizard

For Microsoft Office Access '''

Design Tab → Select 'Control Wizards' (Refer Figure 9.23) → Select the button indicated as 
XXXX → Establish the button in data form → Select Record Operation in Command Button 
Wizard (Refer Figure 9.24) → Select the Action which should be entered (E.g.: Add New 
Record) → Give a proper name to the button → Finish
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9.7   Designing Query to Get Information
	

	 Let us use a query to obtain necessary information from the data of related 
tables. Query represents data of selected fields (columns) in each table. (Refer 
Figure 9.25)

		  	

			 

			       Figure 9.25 - Obtaining data to a query

Subject Student 
No

Marks

A1 B1 67
A2 B3 89
A1 B3 50
A3 B2 75

 

 
 

 

Student No Name Email
A1 Pubudu Pu2@gmail.com
A2 Faris pari@yahoo.com
A3 Kamalan Kam_n@hotmal.

com
A4 Thanuja Thanu7@slt.lk

Subject 
No

Subject

B1 Maths
B2 Science
B3 English

When Name, Subject and Marks are taken by a query from the three table above, 

Name Subject Marks
Pubudu Maths 67

Faris English 89
Pubudu English 50
Thanuja Science 75
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Designing a Query

	 	

Figure 9.26 –Dialogue Box to select tables

Figure 9.27 – Window to design query

For Microsoft OfficeAccess'''

Create Tab → Query Design → Select the necessary tables (Refer Figure 9.26) → Select the 
necessary field from the tables → Run the query
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Refer figure 9.28 given below for the information received after running the query.

Figure 9.28 – information received after running the query

	 As shown in Figure 9.28, marks scored by students in 2013 and 2014 are 
shown. You can obtain marks scored by students in 2014 only (information shown 
in Figure 9.28) by naming year 2014 as Criteria. (Refer Figure 9.29)

 

	

	 Various calculations can be made using fields through query. Let us learn 
how total marks scored by students are calculated. 
	 Add a new column to the query as Total and build an expression indicating 
the calculation needed.  To get total marks of subject it should be typed as:

   

Figure 9.29 – Giving Criteria for query

Figure 9.30 – Information received after running query with 
Criteria
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    	 Total:[Marks]æ[Maths]¬[Marks]æ[Science]¬[Marks]æ[English]. This can be 
typed (Refer Figure 9.31.) or can be performed by building the expression, right 
click the Mouse button on the column which you expect to get the total and select 
Build command. Then use the Dialogue Box you get. (Refer Figure 9.32)

 

           

Figure 9.32 – Dialogue Box to build the expression
 

	 After running the query built in the way explained above, you get information 
as given in Figure 9.33 which is given below.

Figure 9.31 – Enlarge 'Total' column in the query
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Figure 9.33 – Marks and total of students scored in 2013

9.8 Designing Reports to Present Information

	 Reports are used to obtain printed copies of important information received 
from the data of related tables. Both tables and queries can be used to design reports.

Let us learn how a report is designed using the query given above in Figure 9.33.

Report Wizard can be used to design reports.

Figure 9.35 - Report Wizard used to design reports 

For Microsoft Office Access...

Create Tab → Report Wizard → Select the necessary table or query (Refer Figure 9.34) → 

Select the fields needed for the report from the table or query → Design the report as you need 

clicking Next button → Finish. Then you will get a report as shown in Figure 9.35.
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	 Figure 9.35 – Report which displays the total marks of students in 2013

	
Let us learn how numerical values included in a report are calculated. 

	 For this, let us find the total of admission fees paid by the students. Create a 
table as explained above using Report Wizard including Admission Number, Name 
and Admission Fees. Then change from Report View to Design View. Then you 
will get a report layout as shown in Figure 9.36.

 
Figure 9.36 – Report plan

	 Select the tool given as ‘ab’ on the tool barand establish the text box under 
Report Footer. (Refer Figure 9.37)
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Figure 9.37 – Establishing the text box

	 The text box is indicated as unbound. The reason for this is there is no 
field given to it. To get the total of admission fees, get the Expression Builder 
Dialogue Box to build expressions by clicking the button with three dots in front of 
the Control Source on Property Sheet. (Refer Figure 9.39)

 

                        

	
Figure 9'38 - Property Sheet

Figure 9.30 – Expression Builder Dialogue Box
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	 To get the total of admission fees, type the expression = Sum ([Student 
Table]![Admission Fees]) and type OK. Then change the view from Design View to 
Report View. After that, you will get the report which displays the total of Admission 
Fees. (Refer Figure 9.40)

Figure 9.40 – Report which displays the total of Admission Fees

Printing the Report
	 Change the 'Report View' to 'Print Preview'. Click on the tool shown in 
Figure 9.41. Print the number of copies you need.

 Figure 9.41 – Printing tool

1. Explain the advantages of electronic databases.

2. Explain with examples the features that are available in electronic databases.

     3. Compare electronic and manual database.

     4. Explain what is meant by data encryption is.

     5. Explain relational databases using fields, records and tables. 

     6. Define primary key and provide three examples.

     7. Define composite key and provide three examples.

Activity
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8. Define foreign key and with three examples.

9. Write five disadvantages of data duplication.

10. a) What is a data type? Provide examples for data types .
     b) Explain the reason as to why 'integer' data type is not the best data type for 
           field that stores telephone numbers. 

11. Explain the relationships; one-to-one, one-to-many and many-to-many with 
      two examples for each. 

12. Explain what 'objects' are in Database Management Systems and explain 
       the uses of the objects.

²   Database is defined as the collection of organized data.

²   In a table a column is known as a 'Field' 

²   A raw of a table is known as a 'Record' 

²   Advantages of electronic database 

•  Efficient in searching data.
•  Facilities to get copies.
•  Less storage capacity used for storing data.
•  Efficient analysis of data.
•  Sharing data.
•  Data independence.

²   Characteristic of a database.

•  Avoid data redundancy.
•  Consistency of data.
•  Increased efficiency
•  Increased accuracy 
•  Increased validity
•  Increase the security of data.

²    A column or collection of columns in a table when  records can be identified 
      uniquely is called primary key.

Sammary
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²  If a field (or a combination of fields) of one table can be used to uniquely  
     identify rows in another table, these fields are called the foreign keys.

²   A relationship is built up between two tables by using foreign key.

²   Data redundancy means the same data is stored in several database tables.

²   The type of  data that is relevant to a field is known as data type.

²  In a relational database a relationships such as one-to-one, one-to-many and  
     many-to-many can be exist.

²   To enter and display data, forms can be used.

²   Query is used to obtain information.

²   To present data, reports are used.


